
Life 
Generative Sequencer Player

Rack Extension for Reason

USER MANUAL
version 1.1.0 

Life User Manual www.retouchcontrol.com Page   of  1 58

http://www.retouchcontrol.com


Table of Contents

1. Introduction 4
2. Overview 6
2.1 Front 6
2.2 Back 7
3. Usage 8
3.1 The basic principle of operation 8
3.1.1 Game Rules and Edges Behaviour 9
3.1.2 Changing the cell colors 12
3.2 The dot matrix 13
3.2.1 X, Y and Z CV Modulation Inputs 14
3.3 Initial Seed Cell Configuration 16
3.3.1 Creating and Deleting Cells 16
3.3.2 Selecting cells for editing 17
3.3.3 The Edit Mode contextual menu 18
3.3.4 Using Randomization to create the initial seed configuration 22
3.3.5 Capture the current phase as the initial seed configuration 23
3.4 Sequencer Parameters 24
3.4.1 Resetting "Infinite" Mode 26
3.5 The Output Section 31
3.5.1 Assigning Notes to Channels 32
3.5.2 Assigning a Trigger Probability and Velocity to Channels 33

Life User Manual www.retouchcontrol.com Page   of  2 58

http://www.retouchcontrol.com


3.5.3 The Output edit menu (Notes) 34
3.5.4 Note Output via CV 36
3.5.5 Assigning CV Modulations to Channels 37
3.5.6 The Output Edit Menu (CV) 39
3.5.7 External MIDI mode 40
4. Tips and Tricks 42
4.1 Creating Drum Patterns 42
4.2 Creating Arpeggios and Bass Lines in Ext MIDI Mode (with some help) 44
4.3 Inserting patterns from the "Pattern Library" patch folder 46
5. MIDI Implementation 48
6. Remote Implementation 54
7. Version History 55
8. Appedix A - Oscillator Shapes 56
9. Appendix B - "Game of Life" web resources 58

Life User Manual www.retouchcontrol.com Page   of  3 58

http://www.retouchcontrol.com


1. Introduction

Life is a generative sequencer player based on John Conway’s famous “Game of Life” cellular automaton. Its versatile architecture 
makes it suitable for a variety of applications, such as drum sequencer, melodic sequencer or arpeggiator.

The central display with its 32x32 dot matrix is where the game is played. Create a seed cell configuration, then press play and watch 
the cells evolve. As they move across the dot matrix, they trigger the output channels and generate notes and modulation signals via 
the CV output jacks.

Once you have something playing, there are several options to modify the sequence. First, you can morph the dot matrix using the x, 
y and z controls, which can be randomized or modulated using CV signals. Second, you can customize the notes and CV assigned 
to each channel, set a trigger probability and velocity with some amount of velocity or CV variation. Third, you have control over the 
sequencer parameters, including the number of steps, the step offset, the rate, the amount of swing, the density of the notes and CV 
produced and the overall trigger probability.

All these parameters can be stored inside 8 Variations with instant recall of your settings.

The factory patches include a folder named “Pattern Library” with many interesting seed cell configurations. Additionally, it is possible 
to insert “pre-made” configurations known as “oscillators” from a contextual menu. When you want to create your own configurations, 
there is a complete suite of editing tools at your disposal. You can easily select, copy/paste, shift, rotate and flip cells.

Lastly, the player has an External MIDI mode which allows it to receive notes from an external input, for example another player, a 
midi clip or keyboard. This is where the device shines as a very capable arpeggiator which can generate interesting sequences with 
minimum effort. 
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Product Details:

• Color 32 x 32 dot matrix to play the original "Game of Life" and 3 other game variants, with morphing controls plus randomization
• 32 step sequencer with step offset, selectable rate and swing amount, plus "infinite" mode for ever evolving sequences ("infinite" 

mode can be reset at any step by using a CV signal to create sequences of arbitrary lengths)
• Polyphonic or monophonic mode, plus density and global trigger probability to control the amount of notes generated per step
• Output section comprised of 8 color coded channels with custom note and CV assignments, plus individual trigger probability, 

velocity, velocity and CV variation
• Output Edit menu with commands for duplication, shifting, shuffling and randomization of notes and CVs, velocities, velocity and 

CV variations
• Fully featured edit mode for creating your own cell configurations with cut/copy/paste, plus shift left/right/up/down, rotate left/right, 

flip horizontal/vertical commands     
• Ready to use "oscillators" patterns which can be inserted via a simple mouse click
• 8 Variations which can store snapshots of all the parameter settings and can be switched instantly for fun performances
• External MIDI mode to dynamically assign notes to the output channels from an external midi source with 4 different modes, 

including "As Played" and "Note Number" which are great for creating arpeggios, plus "Drum Kit" and "Drum Kit (inv)"  to play live 
with drum patterns 

• Note, Gate and Modulation CV jacks for each output channel, plus special CV jacks for "Mono" mode
• CV inputs for modulation of the X, Y and Z morphing controls
• Comprehensive MIDI and Remote implementations 
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2. Overview
2.1 Front  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1. Main display which shows the live evolution of cells as the sequence progresses. By pressing on the "Edit" button, users can 
create or modify the starting configuration of cells. With a full palette of editing functions, it’s easy to create even the more complex 
patterns. The X, Y and Z knobs allow to modify the underlying 32x32 dot matrix (more info in section 3.1). 

2. Sequencer area with the main parameters which include the number of steps, the steps offset, the sequence rate in musical 
divisions, the amount of swing, the density of notes, and the overall trigger probability. There is a poly/mono switch which sets how 
many notes are played simultaneously.

1

2

4

3
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2.2 Back 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3. Configuration area for the 8 output channels. For each channel, it is possible to set the output note or CV, the trigger probability, 
the velocity of the note and the amount of velocity or CV variation. There is an edit menu with several options to modify the various 
parameters.  

5

5. Gate, Note and Modulation CV outputs for each of the 8 output channels, plus specific outputs for when the device operates in 
Mono Mode.

4. Variation area which can store 8 different snapshots of all the main parameters.

6. CV Inputs for resetting the number of steps when in INF mode, plus modulation inputs for the X, Y and Z controls

6
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3. Usage
Life Sequencer is a player device and hence it needs to be instantiated on top of an instrument. This can be a synth or a sampler.
The next sections explain the basic principle of operation, how to create a starting cell configuration, how to modify the dot matrix, 
how to set up the sequencer and finally how to configure the output channels.

3.1 The basic principle of operation
The main part of the device is the 32 x 32 dot matrix shown in the central display. Each dot location is where a cell of the "Game of 
Life" can exist. If you press the "Edit" button, you’ll notice that each dot has a color. What exactly do these colors represent? 
Basically, the color of each dot corresponds to the color of one of the 8 output channels. As the cells evolve and move over the dot 
matrix, they trigger the notes or CV corresponding to the color of the output channels. This is the basic mechanism by which the 
sequencer generates notes and CV signals. 
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1. Press on the button 
to enter Edit mode

3. Each dot is linked by 
its color to an output 

channel2. Dot matrix where the 
Game of Life is played. 
Each dot can host a cell
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3.1.1 Game Rules and Edges Behaviour 

Game Rules: in addition to Conway’s original "Game of Life", there are 3 other popular game variants which use different rules for 
the survival and the birth of cells, and they are known as "High Life", "Seeds" and "Day and Night". Simply click in the display to open 
the menu and select a different rule. You’ll find that each rule has its own characteristics and produces different results for the same 
initial cells configuration. 
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Edges Behaviour: there are also 3 different choices for how the edges of the matrix behave, which will influence the cell evolution. 

The "Standard" behavior is the original implementation where cells at the edge effectively have a reduced number of potential 
neighbors, compared to cells inside the matrix (there are no neighbors outside of the matrix edges).

If the behavior is set to "Reflective", a cell at the edge of the matrix will have its neighbors mirrored right outside of it, thus making the 
cell have the same number of potential neighbors as cells inside the matrix. 

If the behavior is set to "Conductive", a cell at the edge of the matrix will "feel" the effect of any neighbors on the opposite edge of the 
matrix, also making the cell have the same number of potential neighbors as cells inside the matrix.
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Both the Game Rules and the Edges Behavior are automatable parameters in the Reason sequencer. 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3.1.2 Changing the cell colors 

At any point, you can change the colors of the cells when in Live mode. Simply click in the display and from the menu, choose Colors 
and then pick one of the available options. If "Matrix" is selected, the cell take on the colors of the underlying dot matrix (see next 
section).  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3.2 The dot matrix
As discussed in the previous section, each dot in the matrix has a color assignment which ultimately corresponds to an output 
channel. The color assignment can be easily changed by using the X, Y and Z morph controls. These are available in both "Live" and 
"Edit" mode. Additionally, you can use the randomize button (shown as a die) to assign random values to the three knobs, or 
modulate the X, Y and Z position via the CV input jacks int the back of the device.

Tip: Changing the color assignments is one of the most important tools to create new sequences or variations of existing sequences. 
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2. Click on the die to randomize the 
position of the X, Y and Z knobs

1. Adjust the X, Y and Z knobs to change 
the color assignments. 

Cmd/Ctrl + click to reset to default values
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3.2.1 X, Y and Z CV Modulation Inputs 

CV signals can be used to modulate the values of the X, Y and Z knobs. Any incoming CV input signal is added to the current values 
of the knobs. To modulate the knobs around their set value in both the negative and positive direction, use bipolar CV signals. 

Life User Manual www.retouchcontrol.com Page   of  14 58

Connect a CV signal to 
modulate the X, Y and Z values

http://www.retouchcontrol.com


If any of the X, Y and Z knobs are modulated via CV, there is a red circle around the knob’s label as shown below. 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3.3 Initial Seed Cell Configuration
Creating the seed configuration of cells is essential to start the "Game of Life" and thus to produce notes and CV. To do that, press 
the "Edit" button to enter "edit mode". 

Tip: Changing the seed cell configuration is another important way to create new sequences or variations of existing sequences.

3.3.1 Creating and Deleting Cells 
While in "edit mode", clicking on a dot will create a cell at that position while clicking on an existing cell will delete it. To create a 
series of cells, keep the mouse pressed and move over the desired dots. Similarly, to erase a series of existing cells, press "Shift" 
and mouse over the cells you want to delete. 
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1. Click on a dot to create a cell. 
Click on a cell to delete it

2. Keep the mouse pressed and drag the 
mouse to create a series of adjacent cells. 
Press "Shift" and drag the mouse over the 

cells you want to delete
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3.3.2 Selecting cells for editing 

It is possible to select several cells for editing. Press "Alt" and drag the mouse over the desired cells. Once selected, the cells are 
shown in green and several editing functions become available from the buttons below the matrix. Additional editing options are 
available from the contextual edit menu which is accessed by pressing "Cmd/Ctrl" and clicking inside the matrix area (see section 
3.3.3 for more details). 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1. Press "Alt" then click and drag 
the mouse over the cells to select

2. Once a selection is made, the 
Quick Edit buttons appear

Shift Buttons: use these buttons to move 
the selection up, down, left or right 

Rotate Buttons: use these buttons to rotate 
the selection to the left or to the right

Flip Buttons: use these buttons to flip the 
selection along the Horizontal or Vertical axis
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3.3.3 The Edit Mode contextual menu 

The contextual Edit Mode menu offers many useful commands. To open it, "Cmd/Ctrl" and click inside the matrix area. The menu is 
divided in 3 sections. The first section called "Selection Edit" is very useful when working with a cell selection. From here you can cut/
copy/paste and also shift, rotate, flip and delete a selection. 
The second section called "Insert" allows to easily insert several pre-made cell configurations also know as "oscillators" because their 
evolution pattern repeats after a certain number of iterations. These oscillators are ordered according to their period, that is, to the 
number of steps needed for the pattern to start over. 
The final section called "Map Edit" has commands for duplicating both the dot matrix and the cells to other Variations, for creating a 
random configuration of cells, for deleting all cells and for changing their appearance. 
All these commands are described in more details on the following pages.  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Shift/Rotate/Flip: commands 
to move, rotate or flip the 
selected cells

Delete: remove the selected 
cells

Cut/Copy/Paste: commands 
for copying and pasting the 
selected cells
Select Al l : command for 
selecting all cells

imagine a rectangle tightly containing 
the cells when Copying a selection  

then execute the Paste command by 
clicking on the dot where you want the 

upper left corner of that rectangle to appear

Copy and Paste details
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which corresponds to the upper left corner 
of the rectangle containing the oscillator

list of available oscillators ranked according 
to the number of iterations it takes for the 

pattern to start over
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duplicates the dot matrix and 
the cells to the desired Variation

randomizes the cells only

sets the color for the cells, 
choose between "White" and 

"Matrix"

Cell Color details

White color selection: the 
cells are mostly white, 

underlying dots are still visible 
but rather small

Matrix color selection: the 
cells take on the color of the 

underlying dots

clears all cells
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3.3.4 Using Randomization to create the initial seed configuration 

You can use randomization to create the initial seed configuration. The "Randomize" option is available from the Edit menu (Ctrl/Cmd 
+ click to open the Edit menu). There is also handy shortcut by pressing "Shift" + "Alt" and clicking inside the matrix when in "Edit" 
mode.   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3.3.5 Capture the current phase as the initial seed configuration 

At any point during the cells’ evolution, it is possible to capture its state and save it as the seed configuration for another Variation or 
even for the same Variation. This is done by "Ctrl/cmd" + clicking on the target variation. For example, if Variation 1 is selected and 
you would like to capture the current phase of the cells as the starting point for Variation 2, simply "Ctrl/cmd" + click on the Variation 2 
button as shown below. By using "Shift" + "Ctrl/Cmd" + click, you don’t only copy the current phase, but also all the other parameters 
of the starting Variation to the target Variation.   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1. "Ctrl/Cmd" + click on Variation 2 to 
copy the current phase of Variation 1 to 

the starting phase of Variation 2

2. Starting phase of Variation 2 
has been copied from the 

current phase of Variation 1

Tip: "Shift"+ "Ctrl/Cmd" + click on 
Variation 2 to copy the current phase of 

Variation 1 and all its sequencer and 
output parameters to Variation 2 
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3.4 Sequencer Parameters
On the left side of the panel, you’ll find the main sequencer controls. These are explained in details below.  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Here you set the number of steps in the sequence. You can choose any number between 1 and 32. Every time the 
sequence returns to step 1, the cell’s initial configuration is reloaded so the same evolution pattern repeats. There is also 
an "infinite" mode where the sequence does not return to step 1 and the cells continue to evolve until they die or find a 
stable cyclic pattern (like in the case of oscillators) 

The steps offset parameter allows you to shift forward in time the sequence by offsetting the step at which the cell’s initial 
configuration is repeated. You can use this to align the sequence to the main beat measure. Of course you can also use 
this creatively to experiment with an existing sequence 

The Rate knob sets the speed of the sequence. Values range from 4/4 to 1/64

Turn the Swing knob to add various amounts of swing to the sequence. Values range from Light to Heavy  

The Density knob controls how busy the generated note patterns are. A low density setting produces fewer notes during 
each step, while a higher density setting produces a higher number of notes  

The Poly/Mono switch sets the polyphony mode for the sequencer. In Poly mode, more than one note can be generated 
at each step. In Mono mode, only one note is generated at each step. Click and drag the mouse upward to change from 
Poly to Mono mode, and vice versa. 

The Global Trigger Probability knob controls the likelihood of notes being sent out to any connected device. At 100%, all 
notes generated by the sequencer are sent out. At lower percentages, only a fraction of the notes generated are sent out
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3.4.1 Resetting "Infinite" Mode  

When the number of steps is set to "Inf", it is possible to reset back to step 1 in two different ways. The first one is to simply click on 
the steps display, as shown below. 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Click here* to reset 
the number of steps to 1

* it is possible to assign the reset functionality to a MIDI button via Remote. The name of the remotable item is "Reset Sequencer".

Number of steps set to "Inf"
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The second one is via the CV input in the back of the device. Any CV signal equal to its maximum value will reset the cell 
configuration and set the number of steps back to 1. By using a CV signal to reset the number of steps, it is possible to go beyond 
the limitation of the 32 steps and create sequences of an arbitrary number of steps. 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Max Gate value will reset the 
steps back to 1

Example 1 Front
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Example 2 Front

Max Curve CV value will reset 
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3.5 The Output Section
The Output section is where you configure the notes and CV modulations which are sent from the 8 output channels. As discussed in 
section 3.1 "The Basic Principle of Operation", each channel is assigned a color with corresponding dots in the matrix. As the cells 
evolve, they move over the different colored dots and trigger the corresponding output channels. This section explains how to assign 
notes to each channel, along with the trigger probability and the velocity. Then it explains how to configure the CV modulation 
outputs. It also discusses the "Ext MIDI" mode which further expands the potential uses for the device.  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3.5.1 Assigning Notes to Channels 

To assign a note to a channel, simply click on the corresponding display and choose a note value from the menu. Alternatively, hold 
down "Shift" and drag the mouse up or down. You can randomize a particular channel by holding down "Cmd/Ctrl" + "Alt" and clicking 
on its display. To reset a channel to default values, hold down "Cmd/Ctrl" and click on the display.  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Method 1: click in the display to 
select a note value from the menu Method 2: hold down "Shift" and 

drag the mouse up or down

"Cmd/Ctrl" + "Alt" click in the 
display to randomize the note

"Cmd/Ctrl" click in the display to 
reset to the default value
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3.5.2 Assigning a Trigger Probability and Velocity to Channels 

For each note channel, you can set a trigger probability and a velocity with velocity variation. 
The trigger probability is particularly useful for injecting a bit of variation into otherwise static sequences.Turning the trigger probability 
all the way to zero effectively mutes the corresponding channel. You can also use a shortcut to do that by holding down "Alt" and 
then clicking in the note display. When a channel is muted, the display shows an "M". 

The velocity knob sets the velocity of the outgoing note. If the velocity variation is zero, then all the notes are sent with the same 
velocity. If the velocity variation is greater than zero, then the velocity of the outgoing notes is randomly assigned according to the 
normal distribution where the value set by the velocity knob represents the center of the distribution "mu" and the value set by the 
velocity variation represents the "sigma".  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turn the trigger probability to 
zero and mute the channel  

the velocity knob sets the 
"mu" of the distribution, 
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3.5.3 The Output edit menu (Notes) 

The Output edit menu offers several commands which make it easier to work with note and velocity assignments. Also, from this 
menu you can enable "Ext MIDI Mode" which will be discussed in more details in the next section. To open the Output edit menu, 
click on the downward arrow next to the "Output" label. 
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Insert notes from a scale. 
Important: the note assigned to the first 

channel is used as the root and starting point
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You can choose to shuffle/randomize/reset only 
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3.5.4 Note Output via CV  

Each channel can also output a note via Gate and Note CV from the back fo the device. When "Mono" mode is active, the combined 
note outputs are sent via the dedicated Mono mode Gate and Note CV jacks, as shown below.  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Single channel Gate and 
Note CV outputs

Combined Gate and Note CV
(when "Mono" mode is active)

Mono Mode active
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3.5.5 Assigning CV Modulations to Channels 

As the cell moves across the dot matrix, they can trigger CV modulation signals as well. They are sent via the CV outputs jacks in the 
back of the device.  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Single channel CV 
Modulation Outputs

Combined CV mod output of all 
channels 

(when "Mono" mode is active)

Mono Mode active
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Each cell color has dedicated controls in the front of the device for setting the base CV value and any CV variation. There is a switch 
in the upper right corner of the Output section which allows access to the CV controls. Every time a channel is triggered, the CV 
modulation value is sent from the corresponding output channel and its value is equal to the base CV value, plus any CV variation. 
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Click here to show the 
CV controls

Sets the base CV value

Sets the CV variation % 

Shows the base CV value 
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3.5.6 The Output Edit Menu (CV) 

When CV editing is selected, the Output edit menu displays only information pertinent to the CV controls.  

Life User Manual www.retouchcontrol.com Page   of  39 58

You can choose to shuffle/randomize/reset the 
CV values and the CV Variations

http://www.retouchcontrol.com


3.5.7 External MIDI mode 

If External MIDI mode is enabled from the Output edit menu, the notes assignments for the output channels are bypassed. Instead 
the device works like an arpeggiator and it uses the notes which it receives. For example, if you play chords on your MIDI keyboard, 
then the notes of the chord are going to be used as the output notes for the sequence. The same thing is true if you use a chord 
player on top of the Life player. 
There are several settings concerning how External MIDI Mode works. These are explained below. The "Note Order" has a few 
interesting options, so pay attention to that. When combined with the Poly/Mono switch in the Sequencer area, you’ll find that 
External MIDI mode has a lot of fun uses and it can yield some great results. 
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Click on "Notes" or "Notes & Velocities" to 
enable "Ext MIDI mode"

If you choose Notes, then only the incoming MIDI 
note values are used. The velocity of the notes is 

set by the velocity and velocity variation knobs

If you choose Notes & Velocities, then both the MIDI 
note values and velocities are used. 

The values of the velocity and velocity variation knobs 
are bypassed
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If "Ext MIDI" mode is enabled, then the "Note 
Order" options become active

As Played: the currently held MIDI notes are 
assigned to the different output channels 

(starting from channel 1) in the temporal order 
in which they were received

Note Number: the currently held MIDI notes 
are assigned to the different output channels 
according to their note value, with the lowest 

note assigned to channel 1, and so on

Drum Kit: the device only listens for incoming 
notes in the range C1 to G1. If such a note is 

received, the corresponding channel is 
unmuted and that note is allowed to play

Drum Kit (Inv): the device only listens for 
incoming notes in the range C1 to G1. If such a 
note is received, the corresponding channel is 

muted and that note is not allowed to play
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4. Tips and Tricks

4.1 Creating Drum Patterns 

Life is capable of creating a variety of drum patterns, from conventional to more experimental. Here are some tips for getting the best 
results. 

Tip#1 Start with the oscillators
The easiest way to get started is to choose a "ready made" oscillator from the contextual menu in Edit mode (cmd/ctrl + click in the 
display to open it). Each oscillator in the list has a different period, so it will repeat its pattern after a certain number of steps. 
Experiment with putting together oscillators with periods which are multiples of each other. Another interesting option is to use 
oscillators with even and odd numbered periods. 

Tip#2 Mute and Unmute channels
Hearing all of the 8 channels going at once can be a bit much. Try to pick out the interesting parts in the pattern by muting and then 
unmuting the channels. A quick way to mute/unmute a given channel is to "Alt" + click in the note display area. 

Tip#3 Try both Poly and Mono modes
Most of the time, Poly mode is the way to go. But sometimes switching the play mode to "Mono" can generate some interesting 
results. This style of programming is called "linear" drumming where only one drum instrument plays at once. When you switch to 
Mono mode, make sure to increase the note Density so that you get enough triggers. 

Tip#4 Shuffle the channel notes 
Once you have a pattern you like, it might be interesting to experiment with shuffling the channel notes around. You basically retain 
the basic rhythm of the pattern, but you re-assign the drum instruments. This can be done easily via the Output Edit menu. Choose 
"Shuffle" and then "Notes". 

Tip#5 Use External MIDI Drum Kit mode 
Similarly to Tip#2, in External MIDI mode with either the "Drum Kit" or "Drum Kit (Inv)" selected for "Note Order", you can experiment 
with drum parts by muting/unmuting certain drums directly from your midi keyboard. Just make sure to play notes C1 to G1 on the 
keyboard. This is a fun way to come up with drum variations.     

Life User Manual www.retouchcontrol.com Page   of  42 58

http://www.retouchcontrol.com


Tip#6 Stack players on top of each other
Sometimes one is not enough. The great things about players in Reason is that you can stack them on top of each other. So if you 
find that one Life instance is not giving you the results you want, you might want to try stacking two of them (or more). Of course 
you’ll have to manage the output channels and it might be a good idea to leave some on in one instance while muting them in the 
other. The advantages of having more than one instance is that you can create very different configurations so that it is easier to 
achieve more interesting patterns, especially for polyrhythms. 
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4.2 Creating Arpeggios and Bass Lines in Ext MIDI Mode (with some help) 

The External MIDI mode can be quite fun and rewarding in general, but it can produce even more interesting results with some help 
from the Note Echo player. Let’s suppose we want to create an arpeggio of chords made up of 4 notes. As each chord is played, the 
4 notes in the chord will fill up the first 4 output channels, while the other channels will remain empty. If we place a Note Echo on top 
of Life, we can fill up those 4 empty channels and thus create some more interesting arpeggios. For example, we could set Note 
Echo with a single repeat and a pitch shift of +5, or +7 or +12. These are usually good choices, but feel free to experiment. This 
approach can work quite well when creating bass lines as well. In that case, we could even increase the numbers of repeats. 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Set "Note Echo" to 1 repeat and 
pitch shift of +7

Additional notes are added to the 
chord notes to fill out all the output 

channels
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Set "Note Echo" to 12 repeats and 
pitch shift of +3 or +4,  and +7, and 

+12

For a single note you play, additional 
notes are added by Note Echo at 

intervals suited for bass

http://www.retouchcontrol.com


4.3 Inserting patterns from the "Pattern Library" patch folder 

In the factory patches, there is a folder named "Pattern Library" which contains many pre-made patterns. Some of these are 
recreations of historical patterns which were discovered over the years by various researchers. In this paragraph, you’ll find tips on 
how to "import" one of these patterns into an existing patch. Let’s suppose you have a patch with a a few Variations already filled, but 
would like to add a factory pattern into an empty Variation. Follow the steps below to do just that. 
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Step 1: save the starting patch into which 
you want to insert the factory pattern

Step 2: open the patch with the factory pattern, 
press "Edit" mode, Alt+click and drag to select the 

pattern and then copy it from the context menu 
(cmd/ctrl+click to open the menu)
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Step 3: re-open the starting patch, select an empty 
Variation, then go to "Edit" mode and from the 

context menu, select "Paste"

Step 4: the factory pattern is now copied into the 
starting patch. 
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5. MIDI Implementation 

     MIDI CC - Parameter

        [4] = Variation
        [5] = OnOff
        [33]=density_V1
        [34]=density_V2
        [35]=density_V3
        [36]=density_V4
        [37]=density_V5
        [39]=density_V6
        [40]=density_V7
        [41]=density_V8
        [42]=trigProb_V1
        [43]=trigProb_V2
        [44]=trigProb_V3
        [45]=trigProb_V4
        [46]=trigProb_V5
        [47]=trigProb_V6
        [48]=trigProb_V7
        [49]=trigProb_V8
        [50]=rate_V1
        [51]=rate_V2
        [52]=rate_V3
        [53]=rate_V4
        [54]=rate_V5
        [55]=rate_V6
        [56]=rate_V7
        [57]=rate_V8
        [58]=steps_V1
        [59]=steps_V2
        [60]=steps_V3
        [61]=steps_V4
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        [62]=steps_V5
        [63]=steps_V6
        [65]=steps_V7
        [66]=steps_V8
        [67]=OffSetsteps_V1
        [68]=OffSetsteps_V2
        [69]=OffSetsteps_V3
        [70]=OffSetsteps_V4
        [71]=OffSetsteps_V5
        [72]=OffSetsteps_V6
        [73]=OffSetsteps_V7
        [74]=OffSetsteps_V8
        [76]=out1TrigProb_V1
        [77]=out1TrigProb_V2
        [78]=out1TrigProb_V3
        [79]=out1TrigProb_V4
        [80]=out1TrigProb_V5
        [81]=out1TrigProb_V6
        [82]=out1TrigProb_V7
        [83]=out1TrigProb_V8
        [84]=out2TrigProb_V1
        [85]=out2TrigProb_V2
        [86]=out2TrigProb_V3
        [87]=out2TrigProb_V4
        [88]=out2TrigProb_V5
        [89]=out2TrigProb_V6
        [90]=out2TrigProb_V7
        [91]=out2TrigProb_V8
        [92] =out3TrigProb_V1
        [93]=out3TrigProb_V2
        [102]=out3TrigProb_V3
        [103]=out3TrigProb_V4
        [104]=out3TrigProb_V5
        [105]=out3TrigProb_V6
        [106]=out3TrigProb_V7
        [107]=out3TrigProb_V8
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        [108]=out4TrigProb_V1
        [109]=out4TrigProb_V2
        [110]=out4TrigProb_V3
        [111]=out4TrigProb_V4
        [112]=out4TrigProb_V5
        [113]=out4TrigProb_V6
        [114]=out4TrigProb_V7
        [115]=out4TrigProb_V8
        [116]=out5TrigProb_V1
        [117]=out5TrigProb_V2
        [118]=out5TrigProb_V3
        [119]=out5TrigProb_V4
        [128]=out5TrigProb_V5
        [129]=out5TrigProb_V6
        [130]=out5TrigProb_V7
        [131]=out5TrigProb_V8
        [132]=out6TrigProb_V1
        [133]=out6TrigProb_V2
        [134]=out6TrigProb_V3
        [135]=out6TrigProb_V4
        [136]=out6TrigProb_V5
        [137]=out6TrigProb_V6
        [138]=out6TrigProb_V7
        [139]=out6TrigProb_V8
        [140]=out7TrigProb_V1
        [141]=out7TrigProb_V2
        [142]=out7TrigProb_V3
        [143]=out7TrigProb_V4
        [144]=out7TrigProb_V5
        [145]=out7TrigProb_V6
        [146]=out7TrigProb_V7
        [147]=out7TrigProb_V8
        [148]=out8TrigProb_V1
        [149]=out8TrigProb_V2
        [150]=out8TrigProb_V3
        [151]=out8TrigProb_V4
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        [152]=out8TrigProb_V5
        [153]=out8TrigProb_V6
        [154]=out8TrigProb_V7
        [155]=out8TrigProb_V8
        [156]=game_rule_V1
        [157]=game_rule_V2
        [158]=game_rule_V3
        [159]=game_rule_V4
        [160]=game_rule_V5
        [161]=game_rule_V6
        [162]=game_rule_V7
        [163]=game_rule_V8
        [227]=vel1_V1
        [164]=vel1_V2
        [165]=vel1_V3
        [166]=vel1_V4
        [167]=vel1_V5
        [168]=vel1_V6
        [169]=vel1_V7
        [170]=vel1_V8
        [171]=vel2_V1
        [172]=vel2_V2
        [173]=vel2_V3
        [174]=vel2_V4
        [175]=vel2_V5
        [176]=vel2_V6
        [177]=vel2_V7
        [178]=vel2_V8
        [179]=vel3_V1
        [180]=vel3_V2
        [181]=vel3_V3
        [182]=vel3_V4
        [183]=vel3_V5
        [184]=vel3_V6
        [185]=vel3_V7
        [186]=vel3_V8

Life User Manual www.retouchcontrol.com Page   of  51 58

http://www.retouchcontrol.com


        [187]=vel4_V1
        [188]=vel4_V2
        [189]=vel4_V3
        [190]=vel4_V4
        [191]=vel4_V5
        [192]=vel4_V6
        [193]=vel4_V7
        [194]=vel4_V8
        [195]=vel5_V1
        [196]=vel5_V2
        [197]=vel5_V3
        [198]=vel5_V4
        [199]=vel5_V5
        [200]=vel5_V6
        [201]=vel5_V7
        [202]=vel5_V8
        [203]=vel6_V1
        [204]=vel6_V2
        [205]=vel6_V3
        [206]=vel6_V4
        [207]=vel6_V5
        [208]=vel6_V6
        [209]=vel6_V7
        [210]=vel6_V8
        [211]=vel7_V1
        [212]=vel7_V2
        [213]=vel7_V3
        [214]=vel7_V4
        [215]=vel7_V5
        [216]=vel7_V6
        [217]=vel7_V7
        [218]=vel7_V8
        [219]=vel8_V1
        [220]=vel8_V2
        [221]=vel8_V3
        [222]=vel8_V4
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        [223]=vel8_V5
        [224]=vel8_V6
        [225]=vel8_V7
        [226]=vel8_V8
        [227]=edges_V1
        [228]=edges_V2
        [229]=edges_V3
        [230]=edges_V4
        [231]=edges_V5
        [232]=edges_V6
        [233]=edges_V7
        [234]=edges_V8

Life User Manual www.retouchcontrol.com Page   of  53 58

http://www.retouchcontrol.com


6. Remote Implementation

To obtain the complete list of all the available parameters which are controllable via Remote, use the "Extract Device Remote Info" 
from the File menu in Reason. Here is a partial list for the parameters of Variation 1.   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7. Version History
Version 1.1.0:
• New games rules ("High Life", "Seeds" and "Day&Night), plus new edge behaviors 
• New CV panel controls and CV output jacks for generating modulation signals 
• Gate, Note and CV jacks specific for "Mono" mode
• "Infinite" mode reset via mouse click or CV input
• CV modulation inputs for the X, Y and Z morphing controls
• Capture the current phase of the cells as the starting seed configuration
• Improved algorithm for generating random seed configurations, plus new randomization shortcut
• Expanded automation list including the game rules and edge behaviors
• New front panel knobs for the Output section

Version 1.0.0: initial release

Life User Manual www.retouchcontrol.com Page   of  55 58

http://www.retouchcontrol.com


8. Appedix A - Oscillator Shapes
Here is the list of all the oscillators shapes available from the Edit menu (when in Edit mode, Cmd/Ctrl + Click in the display to open 
the menu).
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9. Appendix B - "Game of Life" web resources
The most complete list of patterns for the Game of Life can be found at this web address: https://conwaylife.appspot.com/library

For a list of the best known oscillators type, this wiki page is quite useful: https://conwaylife.com/wiki/Oscillator#cite_note-lcm-3

You can find all things related to the "Game of Life" at this site: https://conwaylife.com
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